Pocket PC
User’s Guide

Your Pocket PC 2002 comes with a Hardware Manual in addition to
this Pocket PC User’s Guide. Be sure to read the Hardware Manual
first.
Before using your Pocket PC for the first time,carefully read the
Safety Precautions in the Hardware Manual.
Keep this Pocket PC User’s Guide on hand for reference whenever
using your Pocket PC.

E

To reset the Pocket PC
If your Pocket PC responds slowly, stops responding as expected, or “freezes,” try
resetting it. A reset causes the Pocket PC to restart and re-adjust memory allocation.
Unsaved data in open windows may be lost.
• Use the stylus to press and hold the Reset button for about two seconds.

• CASIO COMPUTER CO., LTD. assumes no responsibility for any damage or loss
resulting from the use of this manual.
• CASIO COMPUTER CO., LTD. assumes no responsibility for any loss or claims by
third parties that may arise through the use of this product.
• CASIO COMPUTER CO., LTD. assumes no responsibility for any damage or loss
caused by deletion of data as a result of malfunction, repairs, or battery replacement.
Be sure to back up all important data on other media to protect against its loss.
• Data can be uploaded from this unit to a personal computer for storage on a hard disk,
floppy diskette, or other storage medium. Be sure to make multiple copies of all
important data to protect against its accidental loss.
• The contents of this manual are subject to change without notice.
• No part of this manual may be reproduced in any form without the express written
consent of the manufacturer.
• Sample displays shown in this manual may differ somewhat from the displays actually
produced by the product.
• Specifications, peripherals, and other items can change suddenly to meet market needs.
Such changes can cause the contents of this manual to become inaccurate.
©2001 CASIO COMPUTER CO., LTD. All rights reserved.
Copyright Information
• Microsoft, ActiveSync, Outlook, Pocket Outlook, Windows, Windows NT, and the
Windows logo are either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries. Microsoft products are licensed to OEMs by
Microsoft Licensing, Inc., a wholly owned subsidiary of Microsoft Corporation.
• All other product and company names mentioned herein may be the trademarks of their
respective owners.
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Chapter 1: Getting Started
Welcome
Congratulations on purchasing your Pocket PC. Its compact size and powerful features and
functions let you keep your most important business and personal information up-to-date and
close at hand. Microsoft® ActiveSync® increases the power of your Pocket PC by allowing you to
synchronize the information on your desktop or laptop computer with your Pocket PC. Picture
yourself in the following situations:
• While walking with a colleague, your cell phone rings and the boss asks if you two are free this
afternoon for an emergency meeting. While your colleague fumbles through his paper
organizer, you press a button on your Pocket PC and instantly see a list of today’s appointments
and meetings. You are quickly able to tell the boss your available times. For more information
on scheduling appointments and meetings, see Chapter 4.
• You’re meeting your friends tonight for dinner and a movie. You download the latest movie
information from the Internet to your desktop computer and then synchronize it with your
Pocket PC. At dinner, you pull out your Pocket PC and review your movie options with your
friends. For more information on downloading Web pages, see Chapter 7.
• A Calendar reminder alerts you that it is time to catch the bus. You grab your Pocket PC and
catch the bus just in time. Because ActiveSync keeps the information on your Pocket PC up-todate, you leisurely review your task list, make notes about the new books and CDs you want to
buy, and read and respond to e-mail messages. When you get back to the office, ActiveSync
transfers any task changes you made, your notes, and your e-mail message responses to your
desktop computer. For more information on ActiveSync, see Chapter 3.

Where to Find Information
This manual provides an overview of the programs on your Pocket PC, and explains how to
connect your Pocket PC to a desktop computer, a network, or the Internet. For information on
your Pocket PC hardware, see the Hardware Manual. For instructions on setting up your Pocket
PC and installing ActiveSync, see the Quick Start Guide. The following table is a guide to
additional information to help you use your Pocket PC.
For information on:
Programs on your Pocket PC

See this source:
This User’s Guide and Pocket PC Help. To
view Help, tap
and then Help.
The CASSIOPEIA CD-ROM.

Additional programs that can be installed on
the Pocket PC
Connecting to and synchronizing with a
desktop computer

The Quick Start Guide or ActiveSync Help
on your desktop computer. To view Help,
click Help and then Microsoft ActiveSync
Help.
The Read Me files, located in the Microsoft
ActiveSync folder on the desktop computer
and on the Pocket PC Companion CD.
http://www.microsoft.com/mobile/pocketpc/

Last-minute updates and detailed technical
information
Up-to-date information on Windows®powered Pocket PCs
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Chapter 2: Basic Skills
Learning to use your Pocket PC is easy. This chapter describes the basic concepts of using and
customizing your Pocket PC.

Hardware Buttons and Stylus
Your Pocket PC has hardware buttons that control actions and scroll functions, and a stylus for
selecting items and entering information.
On the Pocket PC, the stylus replaces the mouse.
• Tap. Touch the screen once with the stylus to open items and select options.
• Drag. Hold the stylus on the screen and drag across the screen to select text and images. Drag
in a list to select multiple items.
• Tap-and-hold. Tap and hold the stylus on an item to see a list of actions available for that item.
On the pop-up menu that appears, tap the action you want to perform.

Today Screen
When you turn on your Pocket PC for the first time each day (or after 4 hours of inactivity),
and then Today. On the Today
you’ll see the Today screen. You can also display it by tapping
screen, you can see at a glance important information for the day.
Tap to switch to a program.
Tap to view notification messages.
Tap to change volume or mute all sounds.
Tap to change date and time.
Tap to open an item.

Your day at a glance.

Tap to view connection status.
Tap to create a new item.
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You may see the following status icons on the command bar or on the navigation bar.
Status Icon

Meaning
Turns all sounds on and off
Backup battery is low, very low, or is not loaded in the Pocket PC
Main batteries are charging
Main batteries are low
Main batteries are very low
Main batteries are full
Connection is active
Synchronization is beginning or ending
Synchronization is occurring
Notification that one or more instant messages were received
Notification that one or more e-mail messages were received
Dial-up connection is active
Direct connection is active

If more notification icons need to be displayed than there is room to display them, the
, will display. Tap the icon to view all notification icons.
Notification icon,

Programs
You can switch from one program to another by selecting it from the
menu. (You can
customize which programs you see on this menu. For information, see “Adjusting Settings,” later
, Programs, and then the
in this chapter.) To access some programs, you’ll need to tap
program name.
You can also switch to some programs by pressing a program button. Your Pocket PC has one or
more program buttons located on its front or side. The icons on the buttons identify the programs
they switch to.
The following table contains a partial list of programs that are on your Pocket PC. Look on the
Pocket PC Companion CD for additional programs that you can install onto your Pocket PC.
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Icon

Program

Description

Calendar

Synchronize information between your device and desktop
computer.
Keep track of your appointments and create meeting
requests.

Contacts

Keep track of your friends and colleagues.

ActiveSync

Inbox
Pocket Internet
Explorer

Send and receive e-mail messages.

Notes

Browse Web and WAP sites, and download new programs
and files from the Internet.
Create handwritten or typed notes, drawings, and
recordings.

Tasks

Keep track of your tasks.

Pocket Excel
MSN
Messenger
Pocket Word
Menu
Card Backup
Tool

Create new workbooks or view and edit Excel workbooks
created on your desktop computer.
Send and receive instant messages with your MSN
Messenger contacts.
Create new documents or view and edit Word documents
created on your desktop computer.
Launch applications and open files.
Back up and restore your device memory data to a memory
card.
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays the active program and current
time, and allows you to switch to programs and close screens.
Use the command bar at the bottom of the screen to perform tasks in programs. The command bar
includes menu names, buttons, and the input panel button. To create a new item in the current
program, tap New. To see the name of a button, tap and hold the stylus on the button. Drag the
stylus off the button so that the command is not carried out.
Tap to change volume or mute the device.
Tap to quickly select a program
you have recently used.
Tap to select a program.

Tap to see additional programs.
Tap to customize the device.
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Pop-up Menus
With pop-up menus, you can quickly choose an action for an item. For example, you can use the
pop-up menu in the contact list to quickly delete a contact, make a copy of a contact, or send an email message to a contact. The actions in the pop-up menus vary from program to program. To
access a pop-up menu, tap and hold the stylus on the item name that you want to perform the
action on. When the menu appears, lift the stylus, and tap the action you want to perform. Or tap
anywhere outside the menu to close the menu without performing an action.

Tap and hold to display the pop-up menu.
Lift the stylus and tap the action you warit.

Tap outside the menu to close it without
performing an action.

Notifications
Your Pocket PC reminds you in a variety of ways when you have something to do. For example, if
you’ve set up an appointment in Calendar, a task with a due date in Tasks, or an alarm in Clock,
you’ll be notified in any of the following ways:
• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your Pocket PC.
and then Settings. In the
To choose reminder types and sounds for your Pocket PC, tap
Personal tab, tap Sounds & Notifications. The options you choose here apply throughout the
Pocket PC.

Enter Information on Your Pocket PC
You have several options for entering new information:
• Use the input panel to enter typed text, either by using the soft keyboard or Character
Recognizer.
• Write directly on the screen.
• Draw pictures on the screen.
• Speak into your Pocket PC microphone to record a message.
• Use Microsoft® ActiveSync® to synchronize or copy information from your desktop computer
to your Pocket PC. For more information on ActiveSync, see ActiveSync Help on your desktop
computer.
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Typing Using the Input Panel
Use the input panel to enter information in any program on your Pocket PC. You can either type
using the onscreen keyboard or write using Letter Recognizer, Block Recognizer, or Tramscriber.
In either case, the characters appear as typed text on the screen.
To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input
Panel button to see your choices.

Select an input method.
Tap to see your choices.
Input Panel button.

When you use the input panel, your Pocket PC anticipates the word you are typing or writing and
displays it above the input panel. When you tap the displayed word, it is inserted into your text at
the insertion point. The more you use your Pocket PC, the more words it learns to anticipate.

Tap here if this is the right word.

To change word suggestion options, such as the number of words suggested at one time,
, Settings, Personal tab, Input, and then the Word Completion tab.
tap

To type with the onscreen keyboard
1. Tap the arrow next to the Input Panel button and then Keyboard.
2. On the keyboard that is displayed, tap the keys with your stylus.

To type with the soft keyboard:
1. Tap the arrow next to the Input Panel button and then Keyboard.
2. On the soft keyboard that is displayed, tap the keys with your stylus.
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To use Letter Recognizer:
With Letter Recognizer you can write letters using the stylus just as you would on paper.
1. Tap the arrow next to the Input Panel button and then Letter Recognizer.
2. Write a letter in the box.
When you write a letter, it is converted to typed text that appears on the screen. For specific
instructions on using Letter Recognizer, with Letter Recognizer open, tap the question mark next
to the writing area.

To use Block Recognizer:
With Block Recognizer you can input character strokes using the stylus that are similar to those
used on other devices.
1. Tap the arrow next to the Input Panel button and then Block Recognizer.
2. Write a letter in the box.
When you write a letter, it is converted to typed text that appears on the screen. For specific
instructions on using Block Recognizer, with Block Recognizer open, tap the question mark next
to the writing area.

To use Transcriber:
With Transcriber you can write anywhere on the screen using the stylus just as you would on
paper. Unlike Letter Recognizer and Block Recognizer, you can write a sentence or more of
information. Then, pause and let Transcriber change the written characters to typed characters.
1. Tap the arrow next to the Input Panel button and then Transcriber.
2. Write anywhere on the screen.
For specific instructions on using Transcriber, with Transcriber open, tap the question mark in the
lower right hand corner of the screen.

To select typed text
If you want to edit or format typed text, you must select it first.
• Drag the stylus across the text you want to select.
You can cut, copy, and paste text by tapping and holding the selected words and then tapping an
editing command on the pop-up menu, or by tapping the command on the Edit menu.
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Writing on the Screen
In any program that accepts writing, such as the Notes program and the Notes tab in Calendar,
Contacts, and Tasks, you can use your stylus to write directly on the screen. Write the way you do
on paper. You can edit and format what you’ve written and convert the information to text at a
later time.

To write on the screen
Tap the Pen button to switch to writing mode. This action displays lines on the screen to help you
write.

Tap the Pen button and use
your stylus like a pen.

Some programs that accept writing may not have the Pen button. See the documentation
for that program to find out how to switch to writing mode.

To select writing
If you want to edit or format writing, you must select it first.
1. Tap and hold the stylus next to the text you want to select until the insertion point appears.
2. Without lifting, drag the stylus across the text you want to select.
If you accidentally write on the screen, tap Edit and then Undo and try again. You can also select
text by tapping the Pen button to deselect it and then dragging the stylus across the screen.
You can cut, copy, and paste written text in the same way you work with typed text: tap and hold
the selected words and then tap an editing command on the pop-up menu, or tap the command on
the Edit menu.
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To convert writing to text
Tap Tools and then Recognize.
If you want to convert only certain words, select them before tapping Recognize on the Tools
menu (or tap and hold the selected words and then tap Recognize on the pop-up menu). If a word
is not recognized, it is left as writing.

Select the text you want
to convert and tap Recognize
on the pop-up menu.

The writing is turned
into text.

If the conversion is incorrect, you can select different words from a list of alternates or return to
the original writing. To do so, tap and hold the incorrect word (tap one word at a time). On the
pop-up menu, tap Alternates. A menu with a list of alternate words appears. Tap the word you
want to use, or tap the writing at the top of the menu to return to the original writing.

Tap to return to your original writing.
Or, tap the word you want to use.
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Tips for getting good recognition
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and
apostrophes below the top line so that they are not confused with the word above. Write periods
and commas above the line.
• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so that the Pocket PC can
easily tell where words begin and end.
• Hyphenated words, foreign words that use special characters such as accents, and some
punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to
recognize the word, the writing you add will not be included if you attempt to recognize the
writing again.

Drawing on the Screen
You can draw on the screen in the same way that you write on the screen. The difference between
writing and drawing on the screen is how you select items and how they can be edited. For
example, selected drawings can be resized, while writing cannot.

To create a drawing
Cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or
touching the drawing box become part of the drawing. Drawings that do not cross three ruled
lines will be treated as writing.

The drawing box indicates
the boundaries of the drawing.

Pen button.

You may want to change the zoom level so that you can more easily work on or view your
drawing. Tap Tools and then select a zoom level.
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To select a drawing
If you want to edit or format a drawing, you must select it first.
• Tap and hold the stylus on the drawing until the selection handle appears. To select multiple
drawings, deselect the Pen button and then drag to select the drawings you want.
You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and
then tapping an editing command on the pop-up menu, or by tapping the command on the Edit
menu. To resize a drawing, make sure the Pen button is not selected, and drag a selection handle.

Recording a Message
In any program where you can write or draw on the screen, you can also quickly capture thoughts,
reminders, and phone numbers by recording a message. In Calendar, Tasks, and Contacts, you can
include a recording in the Notes tab. In the Notes program, you can either create a stand-alone
recording or include a recording in a written note. If you want to include the recording in a note,
open the note first. In the Inbox program, you can add a recording to an e-mail message.

To create a recording
1.
2.
3.
4.

Hold your Pocket PC’s microphone near your mouth or other source of sound.
Press and hold the Record hardware button on your Pocket PC until you hear a beep.
While holding down the Record button, make your recording.
To stop recording, release the Record button. Two beeps will sound. The new recording
appears in the note list or as an embedded icon.
You can also make a recording by tapping the Record button on the Recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.

Indicates an embedded
recording.

Tap to begin recording.

Tap to show or hide
the Recording toolber.
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Using My Text
When using Inbox or MSN Messenger, use My Text to quickly insert preset or frequently used
messages into the text entry area. To insert a message, tap My Text and tap a message.

Tap to select a prewritten message.

You can add text after inserting a My Text message before sending it.
To edit a My Text message, in the Tools menu, tap Edit and then tap My Text Messages. Select
the message you wish to edit and make desired changes.
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Find and Organize Information
The Find feature on your Pocket PC helps you quickly locate information.
menu, tap Find. Enter the text you want to find, select a data type, and then tap Go
• On the
to start the search.
To quickly find information that is taking up storage space on your Pocket PC, select
Larger than 64 KB in Type.
You can also use the File Explorer to find files on your Pocket PC and to organize these files into
menu, tap Programs, and then File Explorer.
folders. On the
Tap to change folders.
Select the sort order for the list.
Tap the folder name to open it.

Tap and hold to create
a new folder.

You can move files in File Explorer by tapping and holding the item you want to move
and then tapping Cut or Copy and Paste on the pop-up menu.

Customize Your Pocket PC
You can customize your Pocket PC by adjusting Pocket PC settings and installing additional
software.

Adjusting Settings
You can adjust Pocket PC settings to suit the way you work. To see available options, tap
,
Settings, then the Personal or System tab located at the bottom of the screen.
You might want to adjust the following:
• Clock, to change the time or to set alarms
menu and to enable a pop-up menu from the
• Menus, to customize what appears on the
New button
• Owner Information, to enter your contact information
• Password, to limit access to your Pocket PC
• Power, to maximize battery life
• Today, to customize the information that is displayed on the Today screen
• Brightness, to adjust the brightness of the front light.
• Program Button Control, to disable the front light so it does not light when you press the
Program button.
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Adding or Removing Programs
Programs added to your device at the factory are stored in ROM (read-only memory). You cannot
remove this software, and you’ll never accidentally lose ROM contents. ROM programs can be
updated using special installation programs with a *.xip extension. All other programs and data
files added to your device after factory installation are stored in RAM (random access memory).
You can install any program created for your device, as long as your device has enough memory.
The most popular place to find software for your device is on the Pocket PC Web site
(http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync
You’ll need to install the appropriate software for your Pocket PC on your desktop computer
before installing it on your Pocket PC.
1. Determine your Pocket PC and processor type so that you know which version of the software
and then Settings. On the System tab, tap About. Tap the Version tab, and
to install. Tap
make a note of the information in Processor.
2. Download the program to your desktop computer (or insert the CD or disk that contains the
program into your desktop computer). You may see a single *.xip, *.exe, or *.zip file, a
Setup.exe file, or several versions of files for different Pocket PC types and processors. Be sure
to select the program designed for the Pocket PC and your Pocket PC processor type.
3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.
4. Connect your Pocket PC and desktop computer.
5. Double-click the *.exe file.
• If the file is an installer, the installation wizard will begin. Follow the directions on the screen.
Once the software has been installed on your desktop computer, the installer will automatically
transfer the software to your Pocket PC.
• If the file is not an installer, you will see an error message stating that the program is valid but it
is designed for a different type of computer. You will need to move this file to your Pocket PC.
If you cannot find any installation instructions for the program in the Read Me file or
documentation, use ActiveSync Explore to copy the program file to the Program Files folder on
your Pocket PC. For more information on copying files using ActiveSync, see ActiveSync Help.
Once installation is complete, tap

, Programs, and then the program icon to switch to it.

To add a program directly from the Internet
1. Determine your Pocket PC and processor type so that you know which version of the software
and then Settings. On the System tab, tap About. In the Version tab, make a
to install. Tap
note of the information in Processor.
2. Download the program to your device straight from the Internet using Pocket Internet
Explorer. You may see a single *.xip, *.exe or *.zip file, a Setup.exe file, or several versions of
files for different device types and processors. Be sure to select the program designed for the
Pocket PC and your device processor type.
3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.
4. Tap the file, such as a *.xip or *.exe file. The installation wizard will begin. Follow the
directions on the screen.
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To add a program to the Start menu
Tap
, Settings, Menus, the Start Menu tab, and then the check box for the program. If you do
not see the program listed, you can either use File Explorer on the Pocket PC to move the
program to the Start Menu folder or use ActiveSync on the desktop computer to create a shortcut
to the program and place the shortcut in the Start Menu folder.
• Using File Explorer on the Pocket PC
, Programs, File Explorer, and locate the program (tap the folder list, labeled My
Tap
Documents by default, and then My Device to see a list of all folders on the Pocket PC). Tap
and hold the program and tap Cut on the pop-up menu. Open the Start Menu folder located in
the Windows folder, tap and hold a blank area of the window, and tap Paste on the pop-up
menu. For more information on using File
menu. The program will now appear on the
Explorer, see “Find and Organize Information” earlier in this chapter.
• Using ActiveSync on the desktop computer
Use the Explorer in ActiveSync to explore your Pocket PC files and locate the program. Rightclick the program, and then click Create Shortcut. Move the shortcut to the Start Menu folder
menu. For more information, see
in the Windows folder. The shortcut now appears on the
ActiveSync Help.

To remove programs
• Tap
and then Settings. On the System tab, tap Remove Programs.
If the program does not appear in the list of installed programs, use File Explorer on your
Pocket PC to locate the program, tap and hold the program, and then tap Delete on the pop-up
menu.
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Chapter 3: Microsoft ActiveSync
Using Microsoft® ActiveSync®, you can synchronize the information on your desktop computer
with the information on your Pocket PC. Synchronization compares the data on your Pocket PC
with your desktop computer and updates both computers with the most recent information.
For example:
• Keep Pocket Outlook data up-to-date by synchronizing your Pocket PC with your choice of
Microsoft Outlook data on your desktop computer.
• Synchronize Microsoft Word and Microsoft Excel files between your Pocket PC and desktop
computer. Your files are automatically converted to the correct format.
By default, ActiveSync does not automatically synchronize all types of information. Use
ActiveSync options to turn synchronization on and off for specific information types.
With ActiveSync, you can also:
• Back up and restore your Pocket PC data.
• Copy (rather than synchronize) files between your Pocket PC and desktop computer.
• Control when synchronization occurs by selecting a synchronization mode. For example, you
can synchronize continually while the Pocket PC is connected to your desktop computer (using
a cradle or the cable), or only when you choose the synchronize command.
• Select which information types are synchronized and control how much data is synchronized.
For example, you can choose how many weeks of past appointments you want synchronized.
Before you begin synchronization, install ActiveSync on your desktop computer from the Pocket
PC Companion CD. For more information on installing ActiveSync, see your Quick Start Guide.
After installation is complete, the ActiveSync Setup Wizard helps you connect your Pocket PC to
your desktop computer, set up a partnership so you can synchronize information between your
device and your desktop computer, and customize your synchronization settings. Your first
synchronization process will automatically begin when you finish using the wizard.
After your first synchronization, take a look at Calendar, Contacts, and Tasks on your device.
You’ll notice that information you’ve stored in Microsoft Outlook on your desktop computer has
been copied to your device, and you didn’t have to type a word. Disconnect your Pocket PC from
your computer and you’re ready to go!
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Once you have set up ActiveSync and completed the first synchronization process, you can
initiate synchronization from your Pocket PC. To switch to ActiveSync on your Pocket PC, tap
, and then tap ActiveSync. Note that if you have a wireless LAN card, you can synchronize
remotely from your device.
For information about using ActiveSync on your desktop computer, start ActiveSync on your
desktop computer, and then see ActiveSync Help.

View connection status.
Tap to connect and synchronize.
Tap to stop synchronization.
View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

For more information about ActiveSync on your Pocket PC, switch to ActiveSync, tap
then tap Help.
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, and

Chapter 4: Microsoft Pocket Outlook
Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use
these programs individually or together. For example, e-mail addresses stored in Contacts can be
used to address e-mail messages in Inbox.
Using ActiveSync®, you can synchronize information in Microsoft Outlook or Microsoft
Exchange on your desktop computer with your Pocket PC. You can also synchronize this
information directly with a Microsoft Exchange server. Each time you synchronize, ActiveSync
compares the changes you made on your Pocket PC and desktop computer or server and updates
both computers with the latest information. For information on using ActiveSync, see ActiveSync
Help on the desktop computer.
menu.
You can switch to any of these programs by tapping them on the

Calendar: Scheduling Appointments and
Meetings
Use Calendar to schedule appointments, including meetings and other events. You can check your
appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily switch
views by using the View menu.

Tap to go to today.
Tap to display or edit
the appointment details.

Tap to create a new appointment.

You can customize the Calendar display, such as changing the first day of the week, by
tapping Options on the Tools menu.
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To create an appointment
1. If you are in Day or Week view, tap the desired date and time for the appointment.
2. Tap New.
Tap to return to the calendar
(the appointment is saved automatically).
Tap to choose from
predefined text.
Tap to choose from
previously entered locations.
Tap select a time.
Tap to select a date.

Notes is a good place
for maps and directions.

3. Using the input panel, enter a description and a location. Tap first to select the field.
4. If needed, tap the date and time to change them.
5. Enter other desired information. You will need to hide the input panel to see all available
fields.
6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.
7.
When finished, tap OK to return to the calendar.
If you select Remind me in an appointment, your Pocket PC will remind you according
, Settings, Personal tab, Sounds & Notifications.
to the options set in
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. To change the
appointment, tap Edit.

View appointment details.
View.

Tap to change appointment.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting
request will be created automatically and sent either when you synchronize Inbox or when you
connect to your e-mail server. Indicate how you want meeting requests sent by tapping Tools and
then Options. If you send and receive e-mail messages through ActiveSync, select ActiveSync.

To schedule a meeting
1. Create an appointment.
2. In the appointment details, hide the input panel, and then tap Attendees.
3. From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees.
The meeting notice is created automatically and placed in the Outbox folder.
For more information on sending and receiving meeting requests, see Calendar Help and Inbox
Help on the Pocket PC.
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Contacts: Tracking Friends and Colleagues
Contacts maintains a list of your friends and colleagues so that you can easily find the information
you’re looking for, whether you’re at home or on the road. Using the Pocket PC infrared (IR) port,
you can quickly share Contacts information with other Pocket PC users.
Select the category of contacts
you want displayed in the list.
Tap and enter part of a name to
quickly find it in the list.
Tap to see additional phone
numbers and e-mail addresses.
Tap to display or edit the contact details.
Tap and hold to display
a pop-up menu of actions.

Tap to create a new contact.

To change the way information is displayed in the list, tap Tools and then Options.

To create a contact
1. Tap New.
Tap to return to the contact list
(the contact is saved automatically).

Scroll to see more fields.
Notes is a good place
for maps and directions.

2. Using the input panel, enter a name and other contact information. You will need to scroll
down to see all available fields.
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3. To assign the contact to a category, scroll to and tap Categories and select a category from the
list. In the contact list, you can display contacts by category.
4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.
5. When finished, tap OK to return to the contact list.

Finding a contact
There are four ways to find a contact:
• In the contact list, enter a contact name in the box under the navigation bar. To show all
contacts again, clear text from the box or tap the button to the right of the box.
• In the contact list, tap the category list (labeled All Contacts by default) and select the type of
contact that you want displayed. To show all contacts again, select All Contacts. To view a
contact not assigned to a category, select None.
• To view the names of companies your contacts work for, in the contact list, tap View > By
Company. The number of contacts that work for that company will be displayed to the right of
the company name.
, Find, enter the contact name, select Contacts for the type, and then tap Go.
• Tap

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.
To change the contact information, tap Edit.

View contact details.

Tap to view notes.
Tap to change contact information.
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Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do.
Select the category of tasks
you want displayed in the list.
Select the sort order
of the list.
Indicates high priority.
Tap to display or edit
the task details.
Tap and hold to display
a pop-up menu of actions.

Tap to create a new task.

To change the way information is displayed in the list, tap Tools and then Options.

To create a task
1. Tap New.
Tap to return to the task list
(the task is saved automatically).
Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

2. Using the input panel, enter a description.
3. You can enter a start date and due date or enter other information by first tapping the field. If
the input panel is open, you will need to hide it to see all available fields.
4. To assign the task to a category, tap Categories and select a category from the list. In the task
list, you can display tasks by category.
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5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.
6. When finished, tap OK to return to the task list.
To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap
Tap here to add a new task and enter your task information.

Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

Viewtask details.
Tap to show and hide additional
summary information.
View notes.

Tap to change task.

Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can
create a written note or a recording. You can also include a recording in a note. If a note is open
when you create the recording, it will be included in the note as an icon. If the note list is
displayed, it will be created as a stand-alone recording.

Tap to change the sort
order of the list.
Tap to open a note or
play a recording.
Tap and hold to display
a pop-up menu of actions.

Tap to record.

Tap to create a new item.

Tap show or hide the
Recording toolbar.
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To create a note
1. Tap New.
2. Create your note by writing, drawing, typing, and recording. For more information about using
the input panel, writing and drawing on the screen, and creating recordings, see Chapter 2.
Tap to return to the note list
(the note is saved automatically).

Tap to show or hide
the input panel.
Tap to write on the screen.
Tap to add a recording
to the note.

Inbox: Sending and Receiving E-mail Messages
Use Inbox to send and receive e-mail messages in either of these ways:
• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop
computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an
Internet service provider (ISP) or a network.
We recommend that you reset your CASSIOPEIA periodically, which deletes temporary
files created by the system and frees up user memory. This is especially true if you notice
that remaining user memory capacity is running low. See the Hardware Manual for details
about the reset procedure.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. You will
need to enable Inbox synchronization in ActiveSync. For information on enabling Inbox
synchronization, see ActiveSync Help on the desktop computer.
During synchronization:
• Messages are copied from the mail folders of Exchange or Outlook on your desktop computer
to the ActiveSync folder in Inbox on your Pocket PC. By default, you will receive messages
from the past three days only, the first 100 lines of each message, and file attachments of less
than 100 KB in size.
• E-mail messages in the Outbox folder on your Pocket PC are transferred to Exchange or
Outlook, and then sent from those programs.
• E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in
order to be transferred.
You can also synchronize e-mail messages with your desktop computer from a remote
location. For more information, see Chapter 8.

31

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and
receive e-mail messages by connecting to an e-mail server using a modem or network card
connected to your Pocket PC. You’ll need to set up a remote connection to a network or an ISP,
and a connection to your e-mail server. For more information, see Chapter 8.
When you connect to the e-mail server, new messages are downloaded to the Pocket PC Inbox
folder, messages in the Pocket PC Outbox folder are sent, and messages that have been deleted on
the e-mail server are removed from the Pocket PC Inbox.
Messages that you receive directly from an e-mail server are linked to your e-mail server rather
than your desktop computer. When you delete a message on your Pocket PC, it’s also deleted
from the e-mail server the next time you connect.
You can work online or offline. When working online, you read and respond to messages while
connected to the e-mail server. Messages are sent as soon as you tap Send, which saves space on
your Pocket PC.
When working offline, once you’ve downloaded new message headers or partial messages, you
can disconnect from the e-mail server and then decide which messages to download completely.
The next time you connect, Inbox downloads the complete messages you’ve marked for retrieval
and sends the messages you’ve composed.

Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received
messages are displayed first in the list.
Select the service and folder you want to display.
Select the sort order for messages.
Tap to open a message.
Tap and hold to display
a pop-up menu of actions.

Tap to connect and to send and receive e-mail.
Tap to connect to the selected service.
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When you receive a message, tap it in the list to open it. Unread messages are displayed in bold.
Tap to return to the message list.

Tap delete this message.

Tap to view the previous
or next message.
Tap to replay to or
forward this message.

When you connect to your e-mail server or synchronize with your desktop computer, by default,
you’ll receive messages from the last five days only, the first 100 lines of each new message, and
file attachments of less than 100 KB in size. The original messages remain on the e-mail server or
your desktop computer.
You can mark the messages that you want to retrieve in full during your next synchronization or email server connection. In the message list, tap and hold the message you want to retrieve. On the
pop-up menu, tap Mark for Download. The icons in the Inbox message list give you visual
indications of message status.
You specify your downloading preferences when you set up the service or select your
synchronization options. You can change them at any time.
• Change options for Inbox synchronization using ActiveSync options. For more information, see
ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your Pocket PC. Tap Tools and
then tap Options. On the Service tab, tap the service you want to change.

Important information about attached files!
The system creates a temporary file whenever you open a file attached to a mail message while in
Inbox. Sometimes, such temporary files remain in memory even after you close the attached file.
You can delete leftover temporary files by performing the reset operation. We recommend that
you periodically reset your pocket PC in order to delete accumulated temporary files and free up
the memory they use. See the Hardware Manual for details about the reset procedure.
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Composing E-mail Messages
To compose an e-mail message
1. Tap New.
2. In the To field, enter an e-mail address of one or more recipients, separating them with a
semicolon, or select a name from the contact list by tapping the Address Book button.
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.
Tap to send the message.

Tap to show or hide
the complete header.

Tap to show/hide the
recording toolbar.
Tap to display the Address Book.
Tap to insert common messages.

3. Compose your message. To enter preset or frequently used messages, tap My Text and select a
message.
4. Tap Send when you’ve finished the message. If you are working offline, the message is moved
to the Outbox folder and will be sent the next time you connect.

Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created: Inbox,
Deleted Items, Drafts, Outbox, and Sent Items. The Deleted Items folder contains messages that
have been deleted on the Pocket PC. The behavior of the Deleted and Sent Items folders depends
on the options you have chosen. In the message list, tap Tools and then Options. On the Message
tab, select your options.
If you want to organize messages into additional folders, tap Tools, and then Manage Folders to
create new folders. To move a message to another folder, in the message list, tap and hold the
message and then tap Move to on the pop-up menu.
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Folder behavior with a direct connection to an e-mail server
The behavior of the folders you create depends on whether you are using ActiveSync, POP3, or
IMAP4.
• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be
synchronized with your device. You can select to synchronize additional folders by designating
them for ActiveSync. The folders you create and the messages you move will then be mirrored
on the server. For example, if you move two messages from the Inbox folder to a folder named
Family, and you have designated Family for synchronization, the server creates a copy of the
Family folder and copies the messages into that folder. You can then read the messages while
away from your desktop computer.
• If you use POP3 and you move e-mail messages to a folder you created, the link is broken
between the messages on the Pocket PC and their copies on the mail server. The next time you
connect, the mail server will see that the messages are missing from the Pocket PC Inbox and
delete them from the server. This prevents you from having duplicate copies of a message, but
it also means that you will no longer have access to messages that you move to folders created
from anywhere except the Pocket PC.
• If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on
the server. Therefore, messages are available to you anytime you connect to your mail server,
whether it is from your Pocket PC or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or rename/delete folders when
connected.
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Chapter 5: Companion Programs
The companion programs consist of Microsoft® Pocket Word, Microsoft® Pocket Excel,
Windows Media™ Player for Pocket PC, and Microsoft® Reader. To switch to a companion
menu, and then tap the program name.
program on your Pocket PC, tap Programs on the
Companion programs can open only files stored in the main memory My Documents
folder or a memory card My Documents folder. Any programs that are not in the My
Documents folder do not appear in the program list and cannot be opened.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give you easy access to
copies of your documents. You can create new documents on your Pocket PC, or you can copy
documents from your desktop computer to your Pocket PC. Synchronize documents between your
desktop computer and your Pocket PC so that you have the most up-to-date content in both
locations.
Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create
, Programs, Pocket Word, and then New. A blank document appears. Or, if
a new file, tap
you’ve selected a template for new documents in the Options dialog box, that template appears
with appropriate text and formatting already provided. You can open only one document at a time;
when you open a second document, you’ll be asked to save the first. You can save a document
you create or edit in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text
Format (.rtf), and Plain Text (.txt).
Pocket Word contains a list of the files stored on your Pocket PC. Tap a file in the list to open it.
To delete, make copies of, and send files, tap and hold a file in the list. Then, select the
appropriate action on the pop-up menu.
Select the type of folder you
want displayed in the list.
Tap to change the sort
order of the list.
Tap to open a document.
Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.
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You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and
recording), which are displayed on the View menu. Each mode has its own toolbar, which you can
show and hide by tapping the Show/Hide Toolbar button on the command bar.
You can change the zoom magnification by tapping View and then Zoom. Then select the
percentage you want. Select a higher percentage to enter text and a lower one to see more
of your document.
If you’re opening a Word document created on a desktop computer, select Wrap to
Window on the View menu so that you can see the entire document.

Typing Mode
Using the input panel, enter typed text into the document. For more information on entering typed
text, see Chapter 2.
To format existing text and to edit text, first select the text. You can select text as you do in a Word
document, using your stylus instead of the mouse to drag through the text you want to select. You
can search a document to find the text you want by tapping Edit and then Find/Replace.
Tap and hold to see a
pop-up menu of actions.

Tap to return to the document list
(changes are saved automatically).

Tap to change
formatting options.
Tap to format text.

Tap to show or hide
the toolbar.
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a
guide, and the zoom magnification is greater than in typing mode to allow you to write more
easily. For more information on writing and selecting writing, see Chapter 2.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.
Tap to select formatting options,
such as pen weight and line color.
Space button.
Pen button.

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and
can be edited and manipulated as described in the following section.
Written words are converted to graphics (metafiles) when a Pocket Word document is
converted to a Word document on your desktop computer.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as guides. When you lift
your stylus off the screen after the first stroke, you’ll see a drawing box indicating the boundaries
of the drawing. Every subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see Chapter 2.
Select Shape on the
pup-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow to
see your choices.
Pen button.

Tap to select formatting options,
such as line weight, fill color, and line color.

Recording Mode
In recording mode, embed a recording into your document. Recordings are saved as .wav files.
For more information on recording, see Chapter 2.

For more information on using Pocket Word, tap
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and then Help.

Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to
copies of your workbooks. You can create new workbooks on your Pocket PC, or you can copy
workbooks from your desktop computer to your Pocket PC. Synchronize workbooks between
your desktop computer and your Pocket PC so that you have the most up-to-date content in both
locations.
Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a new
, Programs, Pocket Excel, and then New. A blank workbook appears. Or, if you’ve
file, tap
selected a template for new workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided. You can open only one workbook at a time;
when you open a second workbook, you’ll be asked to save the first. You can save a workbook
you create or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).
Pocket Excel contains a list of the files stored on your Pocket PC. Tap a file in the list to open it.
To delete, make copies of, and send files, tap and hold a file in the list. Then select the appropriate
action from the pop-up menu.
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and
filtering. To display the toolbar, tap View and then Toolbar.

Cell contents appear here
as you enter them.

Format button.
Auto Sum button.
Zoom button.

If your workbook contains sensitive information, you can protect it with a password.
To do so, open the workbook, tap Edit, and then Password. Every time you open the
workbook, you will need to enter the password, so choose one that is easy for you to
remember but hard for others to guess.
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Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel.
• View in full-screen mode to see as much of your worksheet as possible. Tap View and then Full
Screen. To exit full-screen mode, tap Restore.
• Show and hide window elements. Tap View and then tap the elements you want to show or
hide.
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View
and then Freeze Panes. You might want to freeze the top and leftmost panes in a worksheet to
keep row and column labels visible as you scroll through a sheet.
• Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the
split bar to where you want it. To remove the split, tap View and then Remove Split.
• Show and hide rows and columns. To hide a row or column, select a cell in the row or column
you want to hide. Then tap Format, then Row or Column, then Hide. To show a hidden row or
column, tap Tools, then Go To, and then type a reference that is in the hidden row or column.
Then tap Format, then Row or Column, and then Unhide.
For more information on using Pocket Excel, tap
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and then Help.

Windows Media Player for Pocket PC
Use Microsoft Windows Media Player for Pocket PC to play digital audio and video files that are
stored on your Pocket PC or on a network. To switch to Windows Media Player for Pocket PC, tap
, Programs, and then tap Windows Media.

Indicates the progress
of the current track.

Tap to adjust volume.
Tap to skip to the next song.
Tap to play a previous song.
Tap to stop.
Tap to play or pause.

Use Microsoft Windows Media Player on your desktop computer to copy digital audio and video
files to your Pocket PC. You can play Windows Media and MP3 files on your Pocket PC.
For more information about using Windows Media Player for Pocket PC, tap
Help.

, and then tap

You can use the optional Remote Control Earphone (JK-840HE) with Windows Media
Player. To enable the Remote Control Earphone Buttons, use Settings → Remote
Control Earphone to configure initial default settings.
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Microsoft Reader
Use Microsoft Reader to read eBooks on your device. Download books to your desktop computer
from your favorite eBook Web site. Then, use ActiveSync to copy the book files to your activated
device. The books appear in the Reader Library, where you can tap them in the list to open them.
Each book consists of a cover page, an optional table of contents, and the pages of the book. You
can:
• Page through the book by using the Up/Down control on your device or by tapping the page
number on each page.
• Annotate the book with highlighting, bookmarks, notes, and drawings.
• Search for text and look up definitions for words.
The Guidebook contains all the information you’ll need to use the software. To open the
Guidebook, tap Help on the Reader command bar. Or, on a book page, tap and hold on the book
title, and then tap Help on the pop-up menu.
, Programs, and then Microsoft Reader.
To switch to Microsoft Reader, tap

Getting Books on Your Pocket PC
You can download book files from the Web. Just visit your favorite eBook retailer and follow the
instructions to download the book files. Sample books and a dictionary are also included in the
MSReader folder in the Extras folder on the Pocket PC Companion CD. Use ActiveSync to
download the files from your desktop computer to your Pocket PC as described in the Read Me
file in the MSReader folder.

Using the Library
The Library is your Reader home page; it displays a list of all books stored on your Pocket PC or
storage card.
To open the Library:
• On the Reader command bar, tap Library.
• On a book page, tap the book title, and then tap Library on the pop-up menu.
To open a book, tap its title in the Library list.
Tap to scroll through
the Library list.
Tap to select
a sort order.
Tap to open a book.

Tap to specify the
books you want to
display in the list.

Tap here to navigate
to other parts of
the Reader.
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Reading a Book
Each book consists of a cover page, an optional table of contents, and the pages of the book.
Navigation options are listed in the bottom portion of the cover page. The first time you open a
book, you’ll probably want to go to the first page or to the table of contents, if there is one.
Subsequently, whenever you open the book, you’ll be automatically taken to the last page read.
In addition to the text, each book page includes a page number and book title.
Tap to select a navigation option.

Drag to select text and
then tap an option.

Tap arrows to turn the page, or tap
and hold page # to bring up page riffle.

You can also page through a book by using the Action control on your Pocket PC.
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Using Reader Features
Reading a book electronically gives you several options not available with paper books. These
options are available from any book page.
Select text by dragging across the text on the page. Then, tap an option on the pop-up menu, as
described below.
• Search for Text. Find text in a book by tapping Find on the pop-up menu. Enter the word you
want to search for, and tap the desired Find option. The Reader finds the text and highlights it
on the page. Tap outside the Find box to close it. To return to your original page, tap the title
and then tap Return on the pop-up menu.
• Copy Text. You can copy text from books that support this feature into any program that
accepts text. On a book page, select the text you want to copy. Then, tap Copy Text on the popup menu. The text can be pasted into the program of your choice.
• Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon appears in the
right margin. You can add multiple bookmarks to a book. Then, from anywhere in the book,
you can tap the bookmark icon to go to the bookmarked page.
• Highlights. When you highlight text, it appears with a colored background, just as if you used
a marker pen.
• Notes. When you attach a note to text, you enter the text in a note pad that appears on top of the
book page. A note icon appears in the left margin. You can show or hide the note by tapping the
icon.
• Drawings. When you add a drawing, a drawing icon appears in the bottom-left corner of the
page, and drawing tools appear across the bottom of the page. Draw by dragging your stylus.
To see a list of a book’s annotations, including bookmarks, highlights, text notes, and
drawings, tap Annotations Index on the book’s cover page. You can tap an entry in the
list to go to the annotated page.

Removing a Book
When you’ve finished reading a book, you may want to delete it to conserve space on your Pocket
PC. If a copy of the book is stored on your desktop computer, you can download it again at any
time. To remove a book from your Pocket PC, tap and hold the title in the Library list and then tap
Delete on the pop-up menu.
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Chapter 6: MSN Messenger
MSN® Messenger on your Pocket PC is an instant messaging program that lets you:
• See who is online.
• Send and receive instant messages.
• Have instant message conversations with groups of contacts.
To use MSN Messenger, you must have a Microsoft Passport™ account or a Microsoft Exchange
e-mail account. You must have a Passport to use MSN Messenger Service. If you have a Hotmail®
or MSN account, you already have a Passport. Once you have obtained either a Microsoft
Passport or a Microsoft Exchange account, you are ready to set up your account.
Sign up for a Microsoft Passport account at http://www.passport.com. Get a free
Microsoft Hotmail e-mail address at http://www.hotmail.com.
To switch to MSN Messenger, tap

, Programs, and then tap MSN Messenger.

Setting Up
Before you can connect, you must enter Passport or Exchange account information.

To set up an account and sign in:
1. In the Tools menu, tap Options.
2. In the Accounts tab, enter your Passport or Exchange account information.
3. To sign in, tap the sign-in screen and enter your e-mail address and password.
If you already use MSN Messenger on your desktop computer, your contacts will show
up on your device without being added again.

Working with Contacts
The MSN Messenger window shows all of your messenger contacts at a glance, divided into
Online and Not Online categories. From this view, while connected, you can chat, send an e-mail,
block the contact from chatting with you, or delete contacts from your list using the pop-up menu.

Tap a contact to start a chat.

Tap and hold to display
a pop-up menu of actions.
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To see others online without being seen, in the Tools menu, tap My Status and select
Appear Offline.
If you block a contact, you will appear offline but will remain on the blocked contact’s
list. To unblock a contact, tap and hold the contact, then tap Unblock on the pop-up
menu.

Chatting with Contacts
Tap a contact name to open a chat window. Enter your message in the text entry area at the bottom
of the screen, or tap My Text to enter a preset message, and tap Send. To invite another contact to
a multi-user chat, in the Tools menu, tap Invite and tap the contact you want to invite.

Enter message.
Tap to send message.

To switch back to the main window without closing a chat, tap the Contacts button. To
revert back to your chat window, tap Chats and select the person whom you were
chatting with.
To know if the contact you are chatting with is responding, look for the message under the text
entry area.

View full chat.

View status of the chat.

For more information on using MSN Messenger, tap
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and then Help.

Chapter 7: Pocket Internet Explorer
Use Microsofot® Pocket Internet Explorer to view Web or WAP pages in either of the following
two ways.
• During synchronization with your desktop computer, download your favorite links and mobile
favorites that are stored in the Mobile Favorites subfolder in Internet Explorer on the desktop
computer.
• Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you’ll
need to create the connection first, as described in Chapter 8.
To switch to Pocket Internet Explorer, tap

and then Internet Explorer.

The Mobile Favorites Folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on
your desktop computer will be synchronized with your Pocket PC. This folder was created
automatically when you installed ActiveSync.

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop
computer is synchronized with Pocket Internet Explorer on your Pocket PC. Both computers are
updated with changes made to either list each time you synchronize. Unless you mark the favorite
link as a mobile favorite, only the link will be downloaded to your Pocket PC, and you will need
to connect to your ISP or network to view the content. For more information on synchronization,
see ActiveSync Help on the desktop computer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can
download mobile favorites to your Pocket PC. Synchronizing mobile favorites downloads Web
content to your Pocket PC so that you can view Web pages while you are disconnected from your
ISP and desktop computer.
Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites quickly.

To create a mobile favorite
1.
2.
3.
4.

In Internet Explorer on your desktop computer, click Tools and then Create Mobile Favorite.
To change the link name, enter a new name in the Name box.
Optionally, in Update, select a desired update schedule.
Click OK. Internet Explorer downloads the latest version of the Web page to your desktop
computer.
5. If you want to download the pages that are linked to the mobile favorite you just created, in
Internet Explorer on the desktop computer, right-click the mobile favorite and then click
Properties. On the Download tab, specify the number of links deep you want to download. To
conserve Pocket PC memory, only go one level deep.
6. Synchronize your Pocket PC and desktop computer. Mobile favorites that are stored in the
Mobile Favorites folder in Internet Explorer are downloaded to your Pocket PC.
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If you did not specify an update schedule in step 3, you will need to manually download
content to keep the information updated on your desktop computer and Pocket PC. Before
synchronizing with your Pocket PC, in Internet Explorer on your desktop computer, click
Tools and then Synchronize. You will see the last time content that was downloaded to
the desktop computer, and you can manually download content if needed.
You can add a button to the Internet Explorer toolbar for creating mobile favorites. In
Internet Explorer on your desktop computer, click View, Toolbars, and then Customize.

To save Pocket PC memory
Mobile favorites take up storage memory on your Pocket PC. To minimize the amount of memory
used:
• In the settings for the Favorites information type in ActiveSync options, turn off pictures and
sounds, or stop some mobile favorites from being downloaded to the Pocket PC. For more
information, see ActiveSync Help.
• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer,
right-click the mobile favorite you want to change and then Properties. On the Download tab,
specify 0 or 1 for the number of linked pages you want to download.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized content and thousands
of popular Web sites. You subscribe to AvantGo channels directly from your Pocket PC. Then, you
synchronize your Pocket PC and desktop computer, or connect to the Internet to download the
content. For more information, visit the AvantGo Web site.

To sign up for AvantGo
1. In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo
information type.
2. In Pocket Internet Explorer on your Pocket PC, tap the Favorites button to display your list of
favorites.
3. Tap the AvantGo Channels link.
4. Tap the Activate button.
5. Follow the directions on the screen. You will need to synchronize your Pocket PC with your
desktop computer and then tap the My Channels button to complete the AvantGo setup.
When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a
few of the most popular channels. To add or remove channels, tap the Add or Remove link.
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Using Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and channels that have been
downloaded to your Pocket PC without connecting to the Internet. You can also connect to the
Internet through an ISP or a network connection and browse the Web.

Hide pictures button.
Favorites button.
Home button.
Refresh button.

To view mobile favorites and channels
1. Tap the Favorites button to display your list of favorites.

Tap the favorite you
want to view.

Tap to add or delete
a folder or favorite link.

2. Tap the page you want to view.
You’ll see the page that was downloaded the last time you synchronized with your desktop
computer. If the page is not on your Pocket PC, the favorite will be dimmed. You will need to
synchronize with your desktop computer again to download the page to your Pocket PC or
connect to the Internet to view the page.
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To browse the Internet:
1. Set up a connection to your ISP or corporate network using Connections, as described in
Chapter 8.
2. To connect and start browsing, do one of the following:
• Tap the Favorites button, and then tap the favorite you want to view.
• Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter
the Web address you want to visit and then tap Go. Tap the arrow to choose from previously
entered addresses.
To add a favorite link while using the Pocket PC, go to the page you want to add, tap and
hold on the page, and tap Add to Favorites.

51

Chapter 8: Getting Connected
You can use your Pocket PC to exchange information with other Pocket PCs as well as your
desktop computer, a network, or the Internet. You have the following connection options.
• Use the infrared (IR) port on your device to send and receive files between two devices. If this
is the method you want to use, see the following section “Transfer Items Using Infrared.”
• Connect to your Internet service provider (ISP). Once connected, you can send and receive email messages by using Inbox and view Web or WAP pages by using Microsoft® Pocket
Internet Explorer. If this is the method you want to use, see “Connect to the Internet.” The
communication software for creating an ISP connection is already installed on your Pocket PC.
Your service provider will provide software needed to install other services, such as paging and
fax services.
• Connect to the network at your company or organization. Once connected, you can send and
receive e-mail messages by using Inbox, view Web or WAP pages by using Pocket Internet
Explorer, and synchronize with your desktop computer. If this is the method you want to use,
see “Connect to Work.”
• Connect to your desktop computer to synchronize remotely. Once connected, you can
synchronize information such as your Pocket Outlook data. If this is the method you want to
use, see ActiveSync Help on your desktop computer or Connections Help on the Pocket PC.

Transfer Items Using Infrared
Using infrared (IR), you can send and receive information, such as contacts and appointments,
between two Pocket PCs.

To send information
1. Switch to the program where you created the item you want to send and locate the item in the
list.
2. Align the IR ports so that they are unobstructed and within a close range.

• The two infrared ports should be within about 20cm from each other.
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3. Tap and hold the item, and tap Beam Item on the pop-up menu.
You can also send items, but not folders, from File Explorer. Tap and hold the item you
want to send, and then tap Beam File on the pop-up menu.

To receive information
1. Align the IR ports so that they are unobstructed and within a close range.
2. Have the owner of the other device send the information to you. Your device will automatically
receive it.

Connect to the Internet
You can connect to your ISP, and use the connection to send and receive e-mail messages and
view Web or WAP pages.
You can connect to the Internet in one of two ways:
• Create a modem connection. If this is the method you want to use, see “To create a modem
connection to an ISP.”
• Use an Ethernet card and a net tap to connect to the network. If this is the method you want to
use, see “To create an Ethernet connection to an ISP.”

To create a modem connection to an ISP:
1. Obtain the following information from your ISP: ISP dial-up access telephone number, user
name, password, and TCP/IP settings. Some ISPs require information in front of the user
name, such as MSN/username.
2. If your device does not have a built-in modem, install a modem card, or use a NULL modem
cable and appropriate adapters to connect an external modem to your Pocket PC through the
serial port.
and then Settings. In the Connections tab, tap Connections. Under The Internet
3. Tap
settings, select Internet Settings and tap Modify.

4. In the Modem tab, tap New.
5. Enter a name for the connection, such as “ISP Connection.”
6. In the Select a modem list, select your modem type. If your modem type does not appear, try
re-inserting the modem card. If you are using an external modem that is connected to your
device with a cable, select Hayes Compatible on COM1.
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7. You should not need to change any settings in Advanced. Most ISPs now use a dynamicallyassigned address. If the ISP you are connecting to does not use a dynamically-assigned
address, tap Advanced and then the TCP/IP tab, and enter the address. When finished, tap
OK and then Next.
8. Enter the access phone number, and tap Next.
9. Select other desired options, and tap Finish.
10.In the Dialing Locations tab, specify your current location and phone type (most phone lines
are tone). These settings will apply to all connections you create.
To start the connection, simply start using one of the following programs. Your device will
automatically begin connecting. Once connected, you can:
• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to
provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connect Directly to an E-mail Server,” later in this chapter.
• Visit Web and WAP pages by using Pocket Internet Explorer. For more information, see
Chapter 7.
• Send and receive instant messages with MSN Messenger. For more information, see Chapter 6.

To create an Ethernet connection to an ISP:
1. You do not need to create a new connection on your Pocket PC. Instead, you must purchase
and configure an Ethernet card that is compatible with your Pocket PC.
2. Obtain the following information from your ISP: user name, password, and domain name.
3. Insert the Ethernet card into your device. For instructions on inserting and using the Ethernet
card, see the owner’s manual for the card.
4. The first time you insert the card, Network Settings will appear automatically so that you can
configure the Ethernet card. Most networks use DHCP, so you should not have to change these
settings unless your network administrator instructs you to do so. Tap OK. (If it does not
and then Settings. In the Connections tab, tap
appear or to change settings later, tap
Network, tap the adapter you want to change, and then tap Properties.)
5. Connect the Ethernet card to the network by using a network cable. For information, see your
owner’s manual.
, Settings, Connections tab, and then Connections. From the My network card
6. Tap
connects to list, select The Internet.
To start the connection, simply start using one of the programs listed in the preceding section.
Once connected, you can perform the same activities as listed in the preceding section.

Connect to Work
If you have access to a network at work, you can send e-mail messages, view intranet pages,
synchronize your device, and possibly access the Internet. You can connect to work in one of two
ways:
• Create a modem connection by using a RAS account. Before you can create this modem
connection, your network administrator will need to set up a RAS account for you. If this is the
method you want to use, see “To create a modem connection to a network.” Your network
administrator may also give you VPN settings.
• Use an Ethernet card and a net tap to connect to the network. If this is the method you want to
use, see “To create an Ethernet connection to a network.”
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To create a modem connection to a network:
1. Get the following information from your network administrator: dial-up access telephone
number, user name, password, domain name, and TCP/IP settings.
2. If your device does not have a built-in modem, install a modem card.
and then Settings. In the Connections tab, tap Connections. Under The Work
3. Tap
settings, select Work Settings and tap Modify.

4. In the Modem tab, tap New.
5. Enter a name for the connection, such as “Company Connection.”
6. In the Select a modem list, select your modem type. If your modem type does not appear, try
reinserting the modem card. If you are using an external modem that is connected to your
device with a cable, select Hayes Compatible on COM1.
7. You should not need to change any settings in Advanced. Most servers now use a
dynamically-assigned address. If the server you are connecting to does not use a dynamicallyassigned address, tap Advanced and then the TCP/IP tab and enter the address. When
finished, tap OK and then Next.
8. Enter the access phone number, and tap Next.
9. Select other desired options, and tap Finish.
10.In the Dialing Locations tab, specify your current location and phone type (most phone lines
are tone). These settings will apply to all connections you create.
To start the connection, simply start using one of the following programs. Your Pocket PC will
automatically begin connecting. Once connected, you can:
• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to
provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connect Directly to an E-mail Server,” later in this chapter.
• Visit Internet or intranet Web or WAP pages by using Pocket Internet Explorer.
• Send and receive instant messages with MSN Messenger. For more information, see Chapter 6.
• Synchronize. For more information, see ActiveSync Help on the desktop computer.
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To create an Ethernet connection to a network:
1. You do not need to create a new connection on your Pocket PC. Instead, you must purchase
and configure an Ethernet card that is compatible with your Pocket PC.
2. Get the following information from your network administrator: user name, password, and
domain name.
3. Insert the Ethernet card into your device. For instructions on inserting and using the Ethernet
card, see the owner’s manual for the card.
4. The first time you insert the card, Network Settings will appear automatically so that you can
configure the Ethernet card. Most networks use DHCP, so you should not have to change these
settings unless your network administrator instructs you to do so. Tap OK. (If it does not
and then Settings. On the Connections tab, tap
appear or to change settings later, tap
Network, tap the adapter you want to change, and then tap Properties.)
5. Connect the Ethernet card to the network by using a network cable. For information, see your
owner’s manual.
, Settings, Connections tab, and then Connections. From the My network card
6. Tap
connects to list, select Work.
, and then ActiveSync. In the Tools menu, tap
7. If you want to synchronize your device, tap
Options. In the PC tab, select Include PC when synchronizing remotely and connect to, and
select your computer’s name. Remote synchronization with a desktop computer will work only
if you have set up a partnership with that computer through ActiveSync and have set
ActiveSync to allow remote connections. Other restrictions apply. For more information on
synchronizing remotely, see ActiveSync Help on the desktop computer.
To start the connection, simply start using one of the programs listed in the preceding section.
Once connected, you can perform the same activities as listed in the preceding section.

End a Connection
To disconnect, do one of the following:
, on your navigation bar, and
• When connected via dial-up or VPN, tap the Connection icon,
then tap End.
• When connected via cable or cradle, detach your Pocket PC from the cable or cradle.
• When connected via Infrared, move the Pocket PC away from the PC.
• When connected via a network (Ethernet) card, remove the card from your Pocket PC.

Connect Directly to an E-mail Server
You can set up a connection to an e-mail server so that you can send and receive e-mail messages
by using a modem or network connection and Inbox on your Pocket PC.
The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway.
You can use multiple e-mail services to receive your messages. For each e-mail service you intend
to use, first set up and name the e-mail service. If you use the same service to connect to different
mailboxes, set up and name each mailbox connection.
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To set up an e-mail service:
• In Inbox on your Pocket PC, tap Services, and then New Service. Follow the directions in the
New Service wizard.
and then Help. When finished, to connect to your e-mail
For an explanation of a screen, tap
server, tap Services and then Connect. For more information on using the Inbox program, see
“Inbox: Sending and Receiving E-mail Messages” in Chapter 4.

Get Help on Connecting
More information on the procedures described here, as well as information on additional
procedures, can be found in the following locations:
• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.
and then Help. Tap View, All Installed Help, and then
• Online Help on the Pocket PC. Tap
Inbox or Connections.
• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync Help
on the Help menu.
• For troubleshooting information, see the Pocket PC Web site at:
http://www.microsoft.com/mobile/pocketpc
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Appendix: Troubleshooting
Reset the Pocket PC and clear memory
To reset the Pocket PC
If your Pocket PC responds slowly, stops responding as expected, or “freezes,” try resetting it. A
reset causes the Pocket PC to restart and re-adjust memory allocation. Unsaved data in open
windows may be lost.
• Use the stylus to press and hold the Reset button for about two seconds.

To clear memory
If you forget your Pocket PC password or want to clear all data from your Pocket PC and return it
to the factory settings, clear memory.
Warning: Clearing memory deletes all data and restores the Pocket PC to its default settings.
Programs installed at the factory remain, while data you have created and programs you have
installed are erased.
1. Turn the Pocket PC on.
2. Press and hold the Power button, and use the stylus to press and hold the Reset button for
about two seconds.
3. If a message appears on the screen, confirm that you want to clear memory.
-orRemove the main and backup batteries, wait 5 minutes, and then reinsert them.
Use ActiveSync to keep a backup of your Pocket PC data so that if you need to clear
memory, you can restore the data on your Pocket PC. For more information, see
ActiveSync Help.

Batteries lose power
When batteries are low, you will see a battery icon in the navigation bar. Replace or recharge low
batteries as soon as possible. When main battery is discharged, your data will be preserved by the
backup battery. If the backup battery is low, you run the risk of losing the data on your Pocket PC.
You want your Pocket PC battery charge to last as long as possible, especially when you’re on the
road. Under normal conditions, you can get many hours of use from a single set of batteries or
from a full charge. Here are a few tips to help you get the most from them.

Use external power whenever possible
Use the AC adapter to plug your Pocket PC into external power whenever possible, especially
when:
• Establishing a remote connection (some modems use a lot of power).
• Using the backlight feature of your Pocket PC display.
• Connecting to a desktop computer.
• Letting the notification light flash for extended periods.
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Shorten auto-suspend time
While on battery power, your Pocket PC automatically suspends operation if you haven’t touched
the hardware buttons or used the stylus for a specified period. Maximize battery life by shortening
and then Settings. On the System tab, tap Power, and then adjust the On
the time. Tap
battery power setting.

Turn off sounds you don’t need
The Pocket PC produces sounds in response to a number of events, such as warnings,
appointments, and screen taps or hardware-button presses. To optimize battery life, turn off any
and then Settings. On the Personal tab, tap Sounds &
sounds you don’t need. Tap
Notifications and clear check boxes on the Volume and Notifications tabs.

Turn off notification light
Tap
and then Settings. On the Personal tab, tap Sounds & Notifications. On the
Notifications tab, clear the Flash light for check box.

If you forget your password
If you forget your password, you’ll need to clear memory on the Pocket PC. See “Reset the
Pocket PC and clear memory,” earlier in this appendix.

If you run out of Pocket PC memory
Memory on your Pocket PC is shared between storage memory and program memory. Storage
memory is used to store the information you create and programs you install. Program memory is
used to run programs on your Pocket PC. The Pocket PC automatically manages the allocation
between storage and program memory. However, in some situations, such as when memory is low,
the Pocket PC may not be able to automatically adjust the allocation. If you receive a message
stating that storage or program memory is unavailable, try the following solutions.

Storage memory
• Move data to a storage card.
, Programs, and then File Explorer. Tap and hold the file you want to move, and tap
• Tap
Cut. Browse to the My Documents folder in the storage card folder, tap Edit, and then tap
Paste. Files stored in folders other than My Documents or stored in subfolders within
subfolders in My Documents may not show up in the list view of some programs. When
using Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item and
tapping Tools or Edit and then Rename/Move.
• Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage tab, select
Store attachments on storage card. All attachments are moved to the storage card, and new
attachments are automatically stored on the storage card.
• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items
on the storage card. In the program, tap Tools and then Options.
• If you are copying files from your desktop computer or another Pocket PC to your Pocket PC,
and then Settings. On the System tab,
try adjusting the slider in the Memory setting. Tap
tap Memory and check whether the slider can be adjusted manually before copying files.
, Programs, and then File Explorer. Tap and hold the file,
• Delete unnecessary files. Tap
and then Find. In
and then tap Delete on the pop-up menu. To find your largest files, tap
the Type list, tap Larger than 64 KB, and then tap Go.

59

• In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools and
then Options. Tap Delete Files and Clear History.
and then Settings. On the System tab, tap
• Remove programs you no longer use. Tap
Remove Programs. Tap the program you want to remove and then Remove.
• Clear program memory as described in the following section. This will free some program
memory so that it can be allocated to storage memory.

Program memory
• Stop programs you are not currently using. In most cases, programs automatically stop to free
needed memory. However, in some situations, such as when confirmation dialog boxes are
waiting for a user response, the program may not be able to automatically stop. To check the
and then Settings. On the System tab, tap Memory and
state of your active programs, tap
then the Running Programs tab. Tap the program you want to view and then tap Activate.
Close any open windows or messages and return the program to list view. If this doesn’t work,
you can stop the program manually. First, make sure that your work is saved by closing open
items and returning the program to list view. Then, stop the program by tapping Stop or Stop
All on the Running Programs tab.
• Clear storage memory as described in the preceding section. This will free some storage
memory so that it can be allocated to program memory.
• Reset your Pocket PC, as described in “Reset the Pocket PC and clear memory,” earlier in this
appendix.

Screen freezes or responds slowly
Reset your Pocket PC. See “Reset the Pocket PC and clear memory,” earlier in this appendix.

Screen is blank
If the Pocket PC doesn’t respond when you briefly press the Power button, press and hold the
button for a full second. If that doesn’t work:
• Make sure your battery cover is locked and all expansion slots are secured.
• Plug the Pocket PC into AC power.
• Change or recharge the main batteries and backup battery.
• Adjust the display brightness. While holding down the Action control, press right or left cursor
buttons to adjust the brightness.
• Adjust the display contrast. While holding down the Action control, press up or down cursor
buttons to adjust the contrast.
• Reset the Pocket PC. See “Reset the Pocket PC and clear memory” earlier in this appendix.

Screen is dark
Prolonged exposure to direct sunlight may cause your Pocket PC screen to temporarily darken.
This is normal for LCD screens and is not permanent.
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Screen is hard to read
If you’re having a hard time viewing a document in Notes, try changing the size of the view. To do
this, tap a zoom percentage on the Tools menu. In Pocket Word and Pocket Excel, on the View
menu, tap Zoom and then select a zoom percentage. In Pocket Internet Explorer, on the View
menu, tap Text Size and then select a size.
If you’re having a hard time viewing Pocket Outlook data, try enlarging the display font. To do
this within Calendar, Tasks, or Contacts, tap Tools, then Options, and then select Use large font.

Inaccurate response to stylus taps
Adjust the touch screen to respond more accurately to screen taps. Tap
and then Settings. On
the System tab, tap Align Screen. You can also launch the touch screen alignment procedure by
holding down the Power button and pressing the Action control.

Slow or no response
Reset the Pocket PC. See “Reset the Pocket PC and clear memory,” earlier in this appendix.

Infrared (IR) connection problems
If you are unable to use IR to transfer information, try the following:
• Transfer only one file or no more than 25 contact cards at a time.
• Orient the IR ports so there is a straight, unobstructed path between, and so they are no further
than 20cm apart.
• Make sure nothing is between the two IR ports.
• Adjust the room lighting. Some types of light interfere with IR connections. Try moving to a
different location or turning off some lights.

Modem connection problems
You may encounter the following problems when using a modem. Additional troubleshooting
information is available in Connections Help on the Pocket PC and ActiveSync Help on the
desktop computer.

Can’t dial out
• Remove your Pocket PC from the cradle or disconnect the cable. You cannot connect using a
modem if your Pocket PC has an active connection with the desktop computer.
• Verify that the modem is firmly seated and connected to your Pocket PC and the telephone
jack.
• Make sure the telephone line is analog. (Analog telephone lines transmit data in analog instead
of digital form. Your home telephone line is most likely analog, while office telephone lines are
often digital.)
• If you create a modem connection for an external modem, select Hayes Compatible on COM1
as your modem. If you are using a modem card, select the modem card as your modem.
• To use an external modem, you need to use a NULL modem cable and appropriate adapters to
connect the external modem to your Pocket PC.
and then Settings. On the
• Make sure the modem is waiting for a dial tone. Tap
Connections tab, tap Connections. Under The Internet settings or Work settings, select your
setting and tap Modify. Tap your connection and tap Next twice. Make sure Wait for dial tone
before dialing is selected.
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• For international calls, allow more time for the call to go through. Tap
and then Settings.
On the Connections tab, tap Connections. Under The Internet settings or Work settings, select
your setting and tap Modify. Tap your connection and tap Next twice. Clear Cancel the call if
not connected within or increase the number of seconds allowed.

Can dial out but can’t make a proper connection
• Make sure the network to which you are trying to connect supports the Point-to-Point Protocol
(PPP). Your Internet service provider or network administrator can verify this.
and then Settings. On the Connections tab, tap
• Verify that the location is correct. Tap
Connections. On the Dialing Locations tab, make sure that Location reflects your current
location. Tap Dialing Patterns to make sure the correct sequence of numbers is being dialed.
For information on dialing patterns, see Connections Help on the Pocket PC.
• Verify that you are using the right phone number for the modem you are trying to reach Tap
and then Settings. On the Connections tab, tap Connections. Under The Internet settings or
Work settings, select your setting and tap Modify. Tap your connection and then Next and
double-check the phone number you are trying to reach.

Connection is unreliable
• Make sure the modem is firmly seated and connected to your Pocket PC and the telephone jack.
and then Settings. On the Connections tab, tap Connections. On
• Disable call waiting. Tap
the Dialing Locations tab, select Disable call waiting. Then enter the disable code specified
by your telephone company.

Network connection problems
The following solutions may help if you encounter problems when using a network card for
network connections. Additional troubleshooting information is available in Connections Help on
the Pocket PC and ActiveSync Help on the desktop computer.
• Verify that you have an Ethernet card that is compatible with your Pocket PC.
and then Settings. On the
• Verify that you have added necessary server information. Tap
Connections tab, tap Network Adapters. Tap your installed adapter (usually your Ethernet
card’s name), tap Properties, and enter any necessary information. Most networks use DHCP,
so you should not have to change these settings unless your network administrator instructs you
to do so.
• If Network Connection isn’t listed as a connection method in the ActiveSync dialog box when
starting synchronization, wait a few minutes and try again. Also, if synchronization does not
start right away, the network is probably busy, and it may take a minute for your Pocket PC to
connect to the network.
• Make sure that the proper drivers for your card are installed on the Pocket PC. For more
information, see the owner’s manual for the network card.
• Verify with your network administrator that your user name and password are correct.
• Verify with your network administrator that the network you are trying to connect to is
available, or try to connect to it from another computer.
• You may need to change the Pocket PC name if you are trying to connect to a network and
cannot because another Pocket PC with the same name is already connected. To change the
and then Settings. On the System tab, tap About, and then the Pocket
Pocket PC name, tap
Device ID tab.
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Cable and cradle connection problems
The following solutions may help if you encounter problems when connecting to your desktop
computer. Additional troubleshooting information is available in Connections Help on the Pocket
PC and ActiveSync Help on the desktop computer.
• Ensure the Pocket PC is turned on.
• If a modem or Ethernet card is inserted into your Pocket PC, remove it.
and then Today. Tap
or
• Ensure that you do not have any other active connections. Tap
at the bottom of the screen and then Disconnect.
• Ensure the cable is securely plugged into the COM port or USB port on your desktop computer.
Use the cable that came with the Pocket PC without any extra cables or extenders attached.
• Plug the other end of the cable securely into the correct port on your Pocket PC. If you are
using a cradle, push your Pocket PC securely into the cradle.
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